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MrSID™ GeoViewer 2.1 User Guide

Introducing MrSID
The MrSID Imaging Language™ integrates seamlessly with your favorite GIS software from ESRI®, 
Intergraph®, ERDAS®, MapInfo®, Bentley®, Smallworld™ and others. Creating MrSID images is 
effortless with the MrSID Geospatial Encoder. And, with the free MrSID Viewers available on the 
LizardTech Web site at www.lizardtech.com, any computer user can enjoy the benefits of MrSID 
imagery. Suddenly, massive images of unlimited size can be instantaneously panned and zoomed 
locally and over networks. Zooming with MrSID is unlike anything you’ve zoomed before because 
with each click of the mouse the image quality gets better instead of worse. MrSID’s speed is attrib-
uted to LizardTech’s patented Selective Decompression™, delivering only the exact number of pixels 
necessary to display or print the portion of the image requested at the optimal resolution of the mon-
itor or output device. This optimizes your workflow by eliminating wasted data transfer, speeding up 
transfer times and dramatically decreasing storage requirements. Now, a 16-gigabyte image will fit 
on a single CD allowing imagery to be easily used in field situations. MrSID is much more than a 
simple compressor, it is a comprehensive imaging language that will enhance your workflow from 
beginning to end. No longer is high-resolution imagery synonymous with huge data files. Now you 
can create, display, explore, manipulate, distribute, archive and print high-quality imagery in a truly 
portable format using the MrSID Imaging Language.

Introducing The MrSID GeoViewer
The MrSID GeoViewer starts viewing an image with the smallest resolution view, and allows you 
complete control to zoom, pan, and navigate through larger and smaller zoom levels. The Geo-
Viewer uses Selective Decompression to decode only the portion of an image necessary for view-
ing. This makes rapid viewing of large images possible, while maintaining maximum image quality.
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GeoViewer 2.1 Release Notes
MrSID GeoViewer 2.1 includes many new and modified features, based on feedback received on 
earlier versions of the program and customer requests:

• Improved user interface & functionality
Improvements include more right-click menu options and changes to make the prod-
uct easier to use. 

• Ability to view, save and print MrSID metadata
One click of the Data button displays the MrSID metadata for an image.  Metadata 
may be copied to the clipboard, saved to a text file, or printed to your desktop printer. 

• Measure distance and area using the Ruler tool

Use the Ruler tool to select an area of an image, and the distances of the segments 
as well as the area of the selection will be displayed.

• Identify map or pixel coordinates in your imagery using the Inquire Cursor tool
Click anywhere in an image to see that location’s pixel or map coordinates.

• Export to GeoTIFF & TIFF with TAB file
Create TAB files for your MrSID image for use in MapInfo; or, export your MrSID 
image to a GeoTIFF image and retain all of the metadata tags from your original Geo-
TIFF image.

• New custom printing options

Select the print scale, and add a title or comments to your print out.

• Select a custom viewing background color

Specify the background color to use when viewing imagery, for the best possible dis-
play of images in various formats and the best possible print output of your MrSID 
images.
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Getting Started

System Requirements
This version of the MrSID GeoViewer requires:

• Windows® 95/98 or Windows NT® 4.0

• 2 MB of available disk space 
• Minimum of 16 MB RAM; 128 MB of RAM is recommended. 
When using the Export function, additional RAM may be necessary. Display speed is fastest using 
monitors set to 16- or 24-bit color. Monitors set to 8-bit color will have a slower response time due to 
MrSID image enhancement, and may display a lower quality image.

Installation
Double-click on the MrSID GeoViewer install icon.

Follow the instructions presented by the installation application.
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Using the MrSID GeoViewer

The MrSID GeoViewer Window
The image below outlines the key sections of the MrSID GeoViewer window.

The Image Display Area
The Image Display Area is the part of the window that displays your MrSID image. The display 
updates in near real-time as you pan and zoom. 

The GeoViewer Toolbar
The Toolbar runs along the top of the MrSID GeoViewer Window. Each button offers a separate 
image-viewing function. 

If you prefer, you can select Small Icons from the Options menu to display the toolbar with small 
icons.
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The Open Button

The Open Button allows you to select a MrSID (*.sid) image to view. When you click the Open but-
ton, the standard Windows Open File dialog box appears. Navigate to the drive and directory where 
a MrSID image is stored. Select a MrSID image (.sid extension) and click OK. You can also open a 
MrSID image by double-clicking the image icon, or by dragging a MrSID image from the Windows 
Explorer into the MrSID GeoViewer window.

Open Recent

You may open recently viewed files by clicking on the down-pointing arrow on the Open button, and 
selecting the file you wish to open from the menu.

The Image Export Button

The Export button calls up the Export dialog box, which allows you to export data from your MrSID 
image to TIFF World, GeoTIFF, and MapInfo TAB format.  You can also choose Export from the 
File menu.
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The Export Dialog Box

While the Export dialog box is open, you may continue to move around the image normally with the 
Pan and Zoom controls. 

If your MrSID dataset has an associated georeferencing file (world file, *.sdw) or a MrSID metadata 
header, the boundaries of the export area are given in this file's coordinate system. If your MrSID 
dataset does not have an associated world file, the boundaries of the export area are given in pixel 
coordinates.

The Export Area section of the Export dialog box has fields for defining the area of your image that 
you wish to export. In the Left, Right, Top, and Bottom fields you may enter the coordinates of the 
area to be exported. The exported image will contain all data within these boundaries.  

You may also use the mouse to select the area you wish to export. Click on the Define Export Area 
button and the cursor will change to a hand.  
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Drag a rectangle surrounding the area you want to export. A blue line shows the boundaries of the 
Export Area, and the Export Area coordinates update automatically. The Left, Right, Top and 
Bottom fields update automatically.

Use the Resolution pull-down menu to select the resampling ratio for your exported file.

The Pict Size information field shows the size of the exported image in pixels, in the form (width x 
height).

The File Size information field shows the size of the exported image.

Push the OK button when you have selected the area you wish to export.  The standard Windows 
Save As dialog box will appear. 

Select a path and filename, and choose TIFF (*.tif), GeoTIFF (*.tif), or TAB (*.tab).  

Note:  A TAB (*.tab) file is used when placing an image using MapInfo.  If you generate a TAB file, 
you must also generate a TIFF version.

Click Save and the export will begin.

Press the Abort button to stop the export while it is running.
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The Resolution pull-down menu

Use the Resolution field pull-down menu to select the resampling ratio for your exported file. The 
values in the Resolution field are the number of pixels in the original MrSID image, which will be 
resampled into a single pixel of the exported TIFF file.

1:1 resolution exports the data pixel-for-pixel with no resampling. 1:2 resolution gives you one pixel 
in the exported file for every two pixels in the original MrSID image, etc. Different resolutions will 
affect the file size and detail of your exported image.

Export Results
When the MrSID GeoViewer successfully exports an image, it creates a TIFF file in the directory 
specified in the Export Save As dialog box. Accompanying the TIFF file will be a georeferencing 
file, or world file, with the extension .tfw. 

If you export from a MrSID image which has a georeferencing file (a world file with the extension 
.sdw), the coordinates in the exported .tfw world file will be given in the coordinate system of the 
original .sdw world file. 

If the original MrSID image has no world file, the coordinates in the exported .tfw world file will be in 
pixels, with an origin of (0,0) in the upper left corner of the image.

Creating a TFW or TAB File When Exporting
The GeoViewer allows you to create a TFW file or a TAB file for your .sid imagery.  To do so, select 
Save Metadata from the File menu.  The standard Save As... dialog box appears, and you may 
choose the file format you wish to save as, and your file name, in that dialog.  If there is no georefer-
encing information associated with a particular file, the Save Metadata option will be grayed out.  

You may also use the Print Metadata option in the File menu to print the file’s georeferencing infor-
mation.

Save Metadata and Print Metadata may also be accessed from the Metadata Viewer window.
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The Print Button

Pressing the Print button selects the portion of the image currently in the GeoViewer window for 
printing. 

The Print dialog allows you to access your Print Setup settings, as well as to select the Print Scale 
and add a Title or Comments to your printout.  To do so, type your text into the Title or Comments 
fields, and select the font you would like to use by clicking on the Set Font buttons.

The Select View Button

When you press the Select View button, you may select the zoom level at which you would like to 
view the image.  FullView zooms the image out, fitting the entire image in the display window.  
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Set View/Scale allows you to select your own viewing area and scale. If your image has associated 
georeferencing information that specifies the unit, that unit will be set in the Set View/Scale dialog. 
Otherwise, if the unit is not set but a world file exists, the GeoViewer sets the unit to meters by 
default.  If there is no world file, the coordinates are shown in pixels.

You may change the units using the Scale Units menu.

The Previous Button

When you press the Previous button, the MrSID GeoViewer reverts to the previous view of the dis-
played MrSID image. You may move backward up to five views.

The Pan Button

The Pan button changes the mouse cursor to pan mode.

With the cursor in pan mode, click and hold the mouse button; you can drag the image data in any 
direction. When you release the mouse button, the new location will come into focus.

This is an alternative to panning with the scroll bars.

The Zoom In Button

The Zoom In button changes the mouse cursor to zoom-in mode.

With the cursor in zoom-in mode, click-and-drag over an area of your image; the selected area will 
be brought into focus in the GeoViewer window. In addition, you can click on a point of your image; 
the display centers on the point you clicked, and zooms in one resolution level.
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The Zoom Out Button

The Zoom Out button changes the mouse cursor to zoom-out mode.

With the cursor in zoom-out mode, click on any point on your image. The display centers on the 
point you clicked, and zooms out one resolution level.

The Ruler Button

The Ruler button changes the cursor to measurement mode and calls up the Measure window.

With the cursor in measurement mode you can draw a polyline (a series of linked line segments) 
and the Measure window will display the length of each of the lines you draw, as well as the area if 
there is an associated georeferencing file.

Note: To obtain accurate measurements, set Units in the Georeferencing menu, and the Scale 
Units in the Option menu to the appropriate unit.

Click once to begin measuring.

Move the mouse, and a rubber-band line will track the cursor, with one end anchored at the first 
point you clicked. The Measure window shows the length of the line segment. 
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Click on a second, third, or additional points to measure additional segments of your polyline. The 
Measure window shows the length of each line segment in turn. Click twice on the last point in your 
polyline to finish measuring. The Measure window shows the total length of the polyline and the 
area, if available.

You can select the text in the Measure window and copy it to the clipboard. 

If your image has associated georeferencing information that specifies the unit, the Measure win-
dow shows distances and area in the coordinate system specified.  Otherwise, if the unit is not set, 
but a world file exists, the GeoViewer sets the unit to meters by default.  If there is no world file, the 
distances and area are shown in pixels.

You may change the units using the Scale Units menu.

If you measure with the Lens tool selected, the area around the cursor is magnified, so you can see 
detailed imagery around the point you are measuring.

Note:  You may select the Measure tool’s polyline color by selecting Measure Color from the 
Options Menu.  Select the color of your choice from the standard Windows color palette.

The Inquire Cursor Button

The Inquire Cursor button allows you to view map coordinates (using the unit defined by the *.sid 
file’s metadata) or X, Y coordinates (pixel location).  A crosshair-style tool snaps to the cursor on the 
image display.  You may use your mouse to move and place the crosshair tool anywhere in the 
image. Click in the image display area and the Inquire Cursor dialog box will interactively update 
the map coordinate or X, Y pixel information.  
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You may also modify the X, Y coordinates within the Inquire Cursor dialog box.  

Enter a new X, Y coordinate, and select the Apply button.  The crosshair indicator will snap to the 
appropriate map coordinate location.  If you enter a coordinate that is outside of the *.sid file’s data 
area, you will receive an error indicating that the input coordinate is outside the extent of the image.

If your image has associated georeferencing information that specifies the unit, the boundaries of 
the export area are given in this coordinate system.  Otherwise, if the unit is not set but a world file 
exists, the GeoViewer sets the unit to meters by default.  If there is no world file, the boundaries of 
the export area are given in pixels.

You may change the units using the Scale Units menu.

The Lens Button

The Lens button displays a round cursor with crosshairs in the center.  This cursor enlarges the 
area around the mouse pointer by two zoom levels and tracks in near real-time as you move the 
mouse.  For example, if you are viewing an image at 4:1, the Lens cursor shows the area around 
the mouse pointer at 2:1.  If you are viewing the image at 1:1 resolution, the magnification is created 
by enlarging the actual pixels in the image.
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If you measure using the Ruler tool with the Lens tool selected, the area around the cursor is mag-
nified, so you can see detailed imagery around the point you are measuring.

The Overview Button

The Overview button opens and closes the Overview window, which displays a thumbnail overview 
of your entire MrSID image for quick navigation.

The Overview window shows an overview of the entire image with white crosshairs indicating the 
area currently displayed in the viewer window.

You can resize the Overview window to any size you wish.

With the Zoom In tool selected, you can click anywhere in the image to zoom in on that location.
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With other tools selected, if you put the mouse cursor inside the Overview window, the cursor 
changes to a hand. 

Click once to Pan the image.  The clicked point will then be displayed in the main viewer window. 
The zoom level will not change. 

The Snap Button

The Snap button copies the current image display to the Windows clipboard. You can then paste 
the imagery into other applications. 

The View Metadata Button

The View Metadata button launches a separate Metadata Viewer window, to display the MrSID 
metadata text. 

All of the metadata tags from the image’s *.sid file header are included.  You may print or save this 
information using the Print Metadata or Save Metadata options in the File menu, or by clicking on 
the Save or Print buttons in the Metadata Viewer window toolbar.  
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The Help Button

 

Select Contents from the Help button or menu to view the MrSID GeoViewer online help program.  

The Scroll Bars

The MrSID GeoViewer has two scroll bars for panning the image data. The left-right scroll bar is 
located across the bottom of the image display area. The up-down scroll bar is located across the 
right side of the image display area. The scroll bars' indicators show the position of the current view 
within your MrSID image.

To pan left, right, up or down, drag the position indicators in the scroll bars in the direction you want 
to pan. You can also pan the image by using the mouse cursor in Pan mode.
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The Zoom Bar

The MrSID GeoViewer has a zoom bar for changing the zoom level (magnification) of the image 
data. The zoom bar is the vertical bar on the right side of the viewer window. The zoom bar consists 
of a vertical track with a slider. Drag the slider up and down to change the zoom level.

The tick-marks on the zoom bar show the resolution levels actually stored in your MrSID image. If 
you select a zoom level in between two tick marks, the imagery will be generated by interpolation 
from the closest stored resolution level.

Drag the zoom slider downward to zoom in (magnify the image). Drag the slider upward to zoom out 
(reduce the image). As you drag, the viewer program zooms the image in near real-time. When you 
release the mouse button, the program redraws the image at the resolution you have set.

The Pixel Size Indicator

The relative pixel size of the image is displayed in a text box directly below the zoom bar.

A value of 1.000 indicates the imagery is being displayed at 1:1; a value of 10.000 indicates ten 
units in the original image are being resampled into one pixel in the display. 

If your image has associated georeferencing information that specifies the unit, the Pixel Size indi-
cator shows the pixel size of the current image display expressed in the specified unit.  Otherwise, if 
the unit is not set but a world file exists, the GeoViewer sets the unit to meters by default. If there is 
no world file, the value is shown in pixels.

You may change the units using the Scale Units menu.

If the geographic pixel size is equal to or greater than the size of a single pixel, or if the resampling 
ratio is one or greater, the pixel size is shown in black. If the geographic pixel size is smaller than 
the size of a single pixel – if the image is zoomed in beyond 1:1 scale -- or if the resampling ratio is 
less than one, the pixel size is shown in red. 
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To set a specific pixel size, enter the size in the text box and press Enter. The image will be redrawn 
at the pixel size you set. To zoom beyond 1:1 scale, type a negative number into the Pixel Size box.

The Status Bar
The Status bar shows redraw progress after panning or zooming. 

When no redraw is in progress, the Status bar shows the coordinates of the mouse cursor, the cur-
rent scale ratio, and the plain-text description of the scale.

The coordinates of the mouse cursor are displayed in the Scale Units set in the Scale Units menu.

The Scale Ratio shows the ratio of one screen unit to one scale unit.

If your image has associated georeferencing information that specifies the unit, all coordinates will 
be given in that specified unit.  Otherwise, if the unit is not set in metadata, but a world file exists, the 
GeoViewer sets the unit to meters by default. If there is no world file, the value is shown in pixels 
with an origin of (0,0) at the upper left corner of the image.

View Grid
Selecting Grid from the View menu turns activates the View Grid feature.  The gridlines are dis-
played in the appropriate multiple-of-ten-meter increment for the current zoom level.  The grid only 
displays in meters.

The Scale Units Menu

The Scale Units menu allows you to select or change the unit used to display your imagery.  Select 
the appropriate unit from the Scale Units option in the Options menu.
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Georeferencing Information

The Georeference dialog box displays the georeferencing information for the current image.

MrSID Support for Georeferenced Imagery
With the release of version 1.3.1 of the MrSID Encoder, the MrSID file format adopted an internal 
metadata structure.  New versions of the Geospatial Encoder continue to produce MrSID world files.  
In addition, all georeferencing data present at the time the image is created is written into the 
image’s internal metadata. 

The MrSID GeoViewer reads geographic metadata in the following way:

1.First, the GeoViewer looks for internal geographic metadata.  If it exists, this data is used when 
viewing your image.

2.Next, the GeoViewer looks for external geographic metadata in a MrSID world file.  If this data 
exists, the geographic information from the world file (pixel width and height, upper left X and Y 
coordinates) overrides the geographic data already in use. Only the pixel width and X, Y coordi-
nates are affected, and the metadata in the original MrSID file is untouched.

This allows you to adjust the geographic information in the MrSID world file if you need to make 
changes to the pixel width, height, or coordinates.

The View Properties Dialog Box

The View Properties dialog box allows you to modify the viewing window’s background color and 
set your preferences.
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Background Color

The MrSID Geospatial Encoder and the GeoViewer both allow you to specify a custom background 
color.  To specify your image background color in a color image, either enter an RGB value or click 
on the Palette button to select the color from the standard Windows color palette.  

The GeoViewer does not support using a RGB background color when viewing grayscale images.  
For grayscale imagery, choose a shade of gray using the G arrow, or type a value into the G field in 
the View Properties dialog box.  The other values will be adjusted to produce a gray.
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Show Display Alerts
If you use CMYK imagery often, you may wish to suppress the CMYK alert dialog box that activates 
when you open a CMYK image in MrSID GeoViewer by selecting Show Display Alerts.  

By default, this option is turned on.  To deactivate this feature, deselect the Show Display Alerts 
option, or, select Do not show this message again in the CMYK alert dialog box.
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Troubleshooting Guide

Installation Troubleshooting
Some systems may not allow the GeoViewer installer to properly install a required Microsoft DLL.  
This may result in a warning similar to the following:

Entry point not found - the procedure entry point_lc_collate_cp 
could not be located in the dynamic link library MSVCRT.dll

Or, the toolbar icons may not appear.  If you encounter either of these issues, the problem can be 
corrected by reinstalling Internet Explorer 4.0 or later.  The Internet Explorer installer is capable of 
updating the MSVCRT.dll file.  Once that file is updated, the toolbar icons will appear, and you will 
not receive the MSVCRT.dll warning.

Display Speed is Slow
If you are experiencing slow response times when viewing MrSID imagery, please check the follow-
ing:

• Is your display set to 8-bit color?
Open your Display control panel by double-clicking on the Display icon in Start/Set-
tings/Control Panel.  Click on the Settings tab at the top of the screen.  Is the Color 
palette setting in the Settings screen set to 256 Color?  If so, set it to High Color (16 
bit) or higher.  Click on OK and follow any additional steps given in the subsequent 
dialog boxes.

• How many zoom levels (n-levs) does your MrSID image have?
When an extremely large file is encoded in the MrSID format with too few zoom levels 
included, the image may be very slow—to display, and when zooming and panning—
because the thumbnail size of the image is so large.  If you are experiencing a long lag 
while viewing MrSID imagery, re-encode the image using MrSID Encoder 1.3.1, and 
include a larger number of zoom levels (up to nine).  See the MrSID Geospatial 
Encoder User Guide for more information. 

Color Shift when Displaying CMYK Images
When you open a CMYK image in the MrSID GeoViewer, your display translates the image into 
RGB for display purposes.  Because of this translation, you might experience a slight color shift 
when viewing CMYK images.  Because of the way that the GeoViewer handles printing, printed out-
put will also be affected.  If you will be working with, and outputting CMYK images often, consider 
recalibrating your monitor so that the display is optimized for CMYK imagery.  
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Unable to View Locked Files
When attempting to view a MrSID file, if you receive the following warning:

you are trying to access an encrypted file.  The MrSID GeoViewer does not read locked files.  

Georeferencing in Images with TIFF World Files
Because TIFF world files do not specify a unit, if a TIFF world file is present, the image will be dis-
played with the unit set to meters.  If you know the unit that should be used, you may change it using 
the Select Units menu.

Background Colors in Grayscale Images
The GeoViewer does not support using a RGB background color when viewing grayscale images.  
For grayscale imagery, choose a shade of gray using the G arrow, or type a value into the G field in 
the View Properties dialog box.  The other values will be adjusted to produce a gray.
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Contacting LizardTech
If you have any questions regarding your MrSID viewing or encoding product, please do not hesitate 
to contact us.

LizardTech, Inc.
The National Building
1008 Western Ave • Suite 200 • Seattle, WA 98104
Phone 206-652-5211 • Fax 206-652-0880
http://www.lizardtech.com
techsupport@lizardtech.com

Technical support hours:  8am - 5pm Pacific time, Monday through Friday.

©1998-2000, LizardTech, Inc. & International Land Systems, Inc.

This software is protected by U.S. Patent No. 5,710,835.  Foreign Patents Pending.

LizardTech, the LizardTech logo, and MrSID are registered trademarks; and Portable Image Format 
is a trademark of LizardTech, Inc.

The MrSID GeoViewer was built by International Land Systems, Inc. (ILS) for LizardTech.  For fur-
ther information, visit http://www.landsystems.com or phone 301-587-7531.

Bentley is a registered trademark of Bentley Software Inc. cadcorp and cadcorp SIS are trademarks 
of cadcorp. ESRI, PC ARC/INFO, ArcView, and ArcCAD are registered trademarks; MapObjects is 
a trademark; and ArcInfo is a service mark of Environmental Systems Research Institute, Inc. 
ERDAS, and ERDAS IMAGINE are registered trademarks of ERDAS, Inc. MapInfo is a regis tered 
trademark of MapInfo Corporation. Intergraph is a registered trademark and GeoMedia and IRAS-C 
are trademarks of Intergraph Corporation.  Smallworld is a trademark of Smallworld. Windows, and 
Windows NT are trademarks or registered trademarks of Microsoft.  All other trademarks are the 
property of the their respective owners.

The Washington DC sample imagery used in this documentation is a mosaic of 349 digital ortho-
photographs produced by the National Capital Planning Commission (NCPC) for the Washington 
Geographic Information System (WGIS).  This imagery is available on CD from VARGIS LLC of 
Herndon, VA, an authorized distributor of the WGIS orthoimagery. Call (800) 834-0225 or fax (703) 
318-7224 for further information.

Paris imagery courtesy of the GeoInformation Group, Cambridge, England.

No part of this document may be reproduced or transmitted by any means without permission from 
the copyright holder.

MrSID GeoViewer User Guide 030700 v 1.4
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